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Gaia by Procedural Worlds 

Welcome! 
 

Thank you for purchasing Gaia! Gaia is a sophisticated tool with a lot of options and 

while you can go as deep as you like to create fully customized environments, you 

can also start easily and quickly. 

To get up and running as fast as possible, please follow this quick start guide. We also 

have a range of guide articles and tutorials in our Canopy Library. You can also find 

more information in our support forum on Canopy. If you enter your problem in the 

search bar on there, there might be a thread with a solution already.  

 

 

Help / Documentation System: This quickstart guide is only a first introduction on how 

to use Gaia. Most of Gaia’s documentation can be found in the help system directly 

on the User Interface. This saves you opening a manual document or website while 

working with the application. 

Look for  a question mark help button in the top right corner:   

  

Clicking this button will display additional information on the UI, providing help for 

the input fields.  

https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/?utm_source=Gaiav320&utm_medium=ManualDocument&utm_campaign=Canopy
https://canopy.procedural-worlds.com/forums/forum/8-gaia-gaia-pro-2021/?utm_source=Gaiav320&utm_medium=ManualDocument&utm_campaign=Canopy
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If you are not sure what a certain option in Gaia does, the help system would be the 

first place to check. For more complex tools or workflow information, the system 

offers links to online help pages in the Canopy Library. 

 

 

Also note that all input fields use tooltips as well that you can see when hovering the 

mouse over the name of the input field: 

 

 

 

PRO TIP:  

 

Did you know that we also have a range of other products to enhance your 

environments in Unity? For example, with GeNA Pro you can now spawn entire towns 

from scratch and automatically connect them with roads! 

 

 

Check out our other products on the next page to learn more! 

  

https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/?utm_source=Gaiav320&utm_medium=ManualDocument&utm_campaign=Canopy
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About Procedural Worlds 
 

At Procedural Worlds our mission is to empower people to create, automate and 

navigate worlds. Our products are easy to use, nicely integrated and well 

supported. 

We service indies, professionals and enterprise with our tools, and deliver custom 

projects for studios, enterprise and government. Our special power is that we have 

both a deep procedural technology stack, and an amazing team of experts, and 

we leverage this unique combination to create applications, games, sims, mapping 

and mmo / metaverse experiences at a fraction of the typical time and cost. Check 

out our gallery, and then contact us. 

We are a Unity Partner, Intel Partner, and have been a top asset store publisher since 

we first launched Gaia in 2015. Our reviews over this time speak for themselves. 

 

Our Products: 

Bundles 

World Building Bundle - 2021 Edition - Get another 20% off our most popular tools with 

this awesome bundle. It includes Gaia Pro 2021, Gena Pro, Ambient Sounds, Pegasus 

and SECTR 2019. 

Tools 

Gaia Pro 2021 - Gaia 2 is an introductory version of Gaia Pro. Gaia 2 expands on the 

original Gaia 1 with multi terrain and biome support. 

GeNa Pro - GeNa Pro os the big brother of GeNa 2. It is a complete re-write, and 

includes all of the capability of GeNa 2 plus the ability to create splines, rivers, roads 

and villages and to shape and fill your terrain with rocks, trees grasses and more. 

GTS - Glyph Terrain Shader – An easy to use terrain shader that enhances the terrain 

rendering with a lot of additional features - creates great results within minutes, works 

across all render pipelines. 

SECTR Complete 2019 - A suite of performance-enhancing tools that enable open 

world streaming, massive mobile games and includes the latest techniques in audio 

occlusion and propagation. 

Ambient Sounds - A tool that creates interactive soundscapes that also comes with 

professionally composed sound effects and music library. 

Pegasus - A system that can drive anything along a path. Great for cut-scenes, and 

even has an ambient ai that supports formations, animation and local avoidance 

for your NPCs and animals! 

  

https://www.procedural-worlds.com/
https://canopy.procedural-worlds.com/gallery/category/2-hero-shots/
https://www.procedural-worlds.com/about/contact-us/
https://assetstore.unity.com/packages/tools/terrain/world-building-bundle-2021-edition-194633
https://assetstore.unity.com/packages/tools/terrain/gaia-pro-2021-terrain-scene-generator-193476
https://assetstore.unity.com/packages/tools/terrain/gena-pro-terrains-villages-roads-rivers-183186
https://assetstore.unity.com/packages/tools/terrain/gts-glyph-terrain-shader-225272
https://assetstore.unity.com/packages/tools/terrain/sectr-complete-2019-144433
https://assetstore.unity.com/packages/tools/audio/ambient-sounds-interactive-soundscapes-142132
https://assetstore.unity.com/packages/tools/animation/pegasus-65397
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Stamp Packs 

As the inventor of the stamp concept, and obsessive landscape creators, we know 

a thing or two about stamps. Check out our Stamp Packs for a range of landscapes 

that work with Unity, our tools, and any other tool that supports the stamp concept. 

Game Ready Levels 

If you have our tools and would like some optimised levels to build your game 

around or learn from, then check out our Game Ready Levels. 

Micro Biomes 

Micro Biomes are small biomes that are designed to be mixed and matched to 

create more interesting environments with Gaia Pro 2021 and GeNa Pro. 

Procedural Spawner Packs 

We take some of the best modular assets in the store and make it easy for you to use 

them in your scene with Gaia Pro and GeNa Pro and our Procedural Spawner Packs. 

Bring your artistic vision to life and procedurally create in minutes what would take 

weeks or months by hand! 

NEW! Canopy community 

 

Find support and tutorials for the above products and discuss game development 

with other Procedural Worlds users. Join us at https://canopy.procedural-

worlds.com/! 

 

Support, Chat, Tutorials, etc. 

 

Canopy – Official Support Site & Community: https://canopy.procedural-

worlds.com/ 

Discord – Community Chat: https://discord.gg/TggjQNN 

Tutorials: https://canopy.procedural-worlds.com/library/ 

Forums: https://canopy.procedural-worlds.com/forums/ 

Website: https://www.procedural-worlds.com/ 

Contact us / Newsletter: https://www.procedural-worlds.com/about/contact-us/  

 

Social Media: 

 

Facebook: https://www.facebook.com/proceduralworlds 

Twitter: https://twitter.com/ProcWorlds 

Instagram: https://www.instagram.com/procedural_worlds/ 

YouTube: https://www.youtube.com/user/btektube  

https://assetstore.unity.com/lists/stamp-packs-14568938603298
https://assetstore.unity.com/lists/game-ready-levels-14568938566388
https://assetstore.unity.com/lists/micro-biomes-14568938607397
https://assetstore.unity.com/lists/procedural-spawner-packs-14568938554200
https://canopy.procedural-worlds.com/
https://canopy.procedural-worlds.com/
https://canopy.procedural-worlds.com/
https://canopy.procedural-worlds.com/
https://discord.gg/TggjQNN
https://canopy.procedural-worlds.com/library/
https://canopy.procedural-worlds.com/forums/
https://www.procedural-worlds.com/
https://www.procedural-worlds.com/about/contact-us/
https://www.facebook.com/proceduralworlds
https://twitter.com/ProcWorlds
https://www.instagram.com/procedural_worlds/
https://www.youtube.com/user/btektube
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Migrating from Gaia 1 
 

Gaia 1 and Gaia 2 / Pro are not directly upwards compatible - but it is possible to 

migrate scenes that were created with Gaia 1 into Gaia 2 / Pro so that you can 

continue working on your terrain with the more advanced tools. Please visit this 

page for information on how to migrate from Gaia 1: 

 

https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-

articles/advanced/migrating-a-gaia-1-scene-to-gaia-2-pro-r124/  

 

Setup  
 

Before you start out with Gaia, please look through these steps to make sure Gaia is 

correctly installed in your project. While these instructions may seem long, the most 

text here is mostly informational, the actual steps you need to perform is just a few 

clicks.  

1. Create a new project in Unity or open the project that you want to use 

Gaia in. 

 

2. <OPTIONAL> In most cases you want to work in linear colour space, and it 

can save you a lot of time to switch the colour space to “Linear” in your 

project before importing Gaia (or any other unity package). By doing so, 

the included assets will be imported in the correct colour space settings 

right away (Otherwise all the assets will be re-imported again when 

switching the colour space later, which can take some time.) 

 

To find out more about colour space please read the official information 

from Unity about this topic and decide which colour space you want to 

use. Unless you are developing for Mobile or VR or have very special 

requirements, you usually want to choose linear colour space. 

 

To switch colour space, open 

Edit > Project Settings > Player 

and adjust the colour space under “Other Settings” 

https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/advanced/migrating-a-gaia-1-scene-to-gaia-2-pro-r124/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/advanced/migrating-a-gaia-1-scene-to-gaia-2-pro-r124/
https://docs.unity3d.com/Manual/LinearRendering-LinearOrGammaWorkflow.html
https://docs.unity3d.com/Manual/LinearRendering-LinearOrGammaWorkflow.html


 

Gaia by Procedural Worlds 

 

 

Don’t worry if you are not sure about this setting – you can always change 

the colour space later in your project, but processing this change then 

can take a while. 

 

3. Install Gaia from the Package Manager under Window > Package 

Manager.  

 

If you purchased Gaia from the PW store you can install Gaia by 

exectuting Assets > Import Package > Custom Package… in the Unity 

editor. 

 

Please note that with Unity 2020 and higher the old Asset Store Window 

has been removed, and you need to download all asset store content via 

the package manager now. 

 

<OPTIONAL> For a better experience with Gaia in the built-in rendering 

pipeline it is recommended to install the Post Processing Package from the 

package manager as well. This is entirely optional – Gaia will work fine 

without post processing installed, but then can’t set up post processing in 

your scene, e.g. for underwater effects or for lighting in your biomes.  

 

This optional step is also not required when using HDRP or URP as these 

rendering pipelines come with their own version of post processing 

automatically. 

 

To install post processing in your project, please open the package 

https://docs.unity3d.com/Manual/upm-ui.html
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manager from Window > Package Manager and locate and install the 

post processing package: 

 

 
 

4. Your entry point to using Gaia is the Gaia Manager Window. After 

importing Gaia from the asset store, you can open the Gaia Manager 

Window from the Window Menu or by pressing Control + G: 

 

 
 

When the Gaia Manager is being opened for the first time after a new 

installation or an update, it will perform an initial maintenance / setup 

process which runs by itself. 

 

If the Gaia Manager Menu entry does not appear: In 99% of the cases this 

is caused by compilation errors in the project. Please check your console 
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for messages that might prevent the successful compilation of your 

project. In a fresh project this is very unlikely to happen, but in a larger, 

living project these errors can have many different causes. If you are stuck 

with a compilation error that you can’t resolve, please contact support. 

 

5. In the Gaia Manager, the Setup Tab will be selected if your project is not in 

linear colour space or deferred rendering mode. It will offer buttons to 

correct this.  

 

 
 

Click these buttons to set your project’s colour space linear and your 

rendering path to deferred in order to get the best visuals and 

performance. This step only ever has to be done once in your project. If 

you performed the switch to linear before as mentioned in Step 2 this 

process will be very fast, otherwise it might take a bit to reimport the assets. 

 

NOTE: If you are using gamma colour space you can ignore this step! 

 

6. <OPTIONAL> Gaia comes with its own water and vegetation shaders 

which also support the Unity scripted rendering pipelines (SRPs). These are 

commonly known under the terms  

 

HDRP – High Definition Rendering Pipeline 

LWRP – Lightweight Rendering Pipeline (deprecated) 

URP – Universal Rendering Pipeline 

 

If you want to use one of these Pipelines, you need to set up Gaia for that 

specific pipeline. If you want to use Unity’s built in rendering, you are done 

with setting up Gaia already. 

Supporting these pipelines can be challenging for asset store developers 

as we need to make sure that features like water use the correct shader 

for the correct pipeline for the correct unity / SRP version. To make this 

easier for you, we have mostly automated this process in the Setup Tab in 

the Gaia Manager: 

https://docs.unity3d.com/Manual/ScriptableRenderPipeline.html
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In this panel you need to do only two things: 

 

A) If you want to use a different pipeline than built-in rendering, select the 

pipeline you want to use and click the button to upgrade Gaia to this 

pipeline. This will change the Gaia tools and functions to the respective 

pipeline. This process can be reverted later as well. If you want to use built-

in rendering only, you don’t need to do perform this step, Gaia is pre-

configured for built in rendering after import already. 

The installation will take 20-60 seconds to complete, as the project needs 

to be recompiled. During the installation you might be asked if you want to 

use Gaias Rendering Pipeline asset or use your own, or if you want to 

switch out terrain shaders as well. If you are not sure about these 

questions, choose “yes” to all questions being asked. 

 

B) After you configured the rendering pipeline, click the “Install Shaders” 

button. This will install the shaders for both the water and the vegetation 

for the correct unity version and the pipeline you selected above. If the 

correct shaders are already installed, this button will not appear. 
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The Gaia setup process is now done. 

 

Please note: Using the SRPs is not recommended for Unity beginners as 

using those pipelines come with their own challenges and limitations you 

need to master. Doing so while just starting out with Unity will make your 

journey more difficult than it needs to be.  

If you decide to use the SRPs please note that all materials you use 

beyond the Gaia vegetation items and the water need to be compatible 

with your target pipeline. Gaia cannot set up materials from other asset 

packs or convert shaders written for a different pipeline automagically for 

you. 

 

When you are switching pipelines it is possible to revert back to built-in 

rendering later and then switch to another pipeline again.  
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Create your first terrain with Gaia – in just a few clicks! 
 

In this scenario we will use Gaia to generate an entire new scene using a simple 

heightmap stamp and a biome preset – this will create an entire terrain for you in just 

a few minutes. 

 

1. Create a new scene. To create a new scene, select File -> New Scene or 

Ctrl + N.  

 
 

In your new scene, open the Gaia Manager by pressing Ctrl + G or the 

Window / Procedural Worlds / Gaia / Show Gaia Manager... menu entry and 

select the “Standard” Tab in the window. 

 

Creating a new scene with Gaia can be done in mostly 3 steps which are 

represented in these tabs in the Gaia Manager as well:  
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1. Set up your project (If you followed the setup instructions at the 

beginning of this guide this should be done already.) 

 

2. Create your world by creating one or more terrains that represent the 

surface area of your world 

 

3. Create Runtime settings such as Lighting, Water, and a Player to explore 

the terrain. 

 

4. <Optional> Use the Build and Deploy tab to build and publish your 

project. This is entirely optional to use, you can still build your project the 

traditional way from the Unity Build Window. 

 

Note that these steps do not necessarily need to be executed in this order 

– it is possible to change the setup of the project during development, or if 

you already have an existing terrain, you do not need to go through the 

“Create World” step. For the sake of this introduction, we will assume you 

are starting from an empty scene. 

 

In a new scene, the Terrain tab is selected per default. Here you can set 

up settings for your world size and the target platform (which offers 

different settings for the visual world quality). You can select a first biome 

here that you want to spawn on your terrain – a biome is a selection of 

textures, trees, vegetation, etc. that fit well together and can be spawned 

together I  

You can also choose which workflow you want to use: Manual Stamping 

or (Semi-) automatic terrain generation with the World Designer. 
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For your first attempt the default settings in here should be fine – you can 

always start this process over to select a different terrain size or quality 

options later. If you are curious, you can click the small “+” buttons to see 

the advanced world size or quality options.  

Select the “Manual with Stamper” workflow, then click on “Create 

Terrain(s)” to create the terrain and set up a stamper tool that will allow 

you to sculpt the terrain.  

 

2. You should see a new terrain being added to the scene, and the Gaia 

Manager will switch forward to the Runtime tab.  

 

 
 

The blue-greenish terrain you see in the scene view now is not your final 

terrain just yet – it is more a real-time preview of the terrain shape we are 

about to create. You should also see a stamp browser window which 

allows you to quickly select one of the stamps (“terrain shapes”) that 

come with Gaia. 
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3. To get a first impression on how the stamper and the preview works, try 

selecting a different stamp in the stamp browser by using the back and 

forward buttons and / or selecting a different stamp category. The 

stamper preview in the scene view should update immediately with your 

selection. Try to find a stamp that appeals to you, ideally it also allows a bit 

of water in the scene (deep blue in the preview) to be visible as well. 

 

 

 

When you are happy with the selected stamp, you can click “Apply”. 
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4. In the unity inspector you should have the stamper controls selected. Click 

“Stamp” at the very bottom of the Stamper to apply the selected stamp 

to the terrain.  

 

 

The following is happening now: 

 

 

 

- The stamper adjusts the heightmap on the terrain to form mountains and 

valleys according to the stamp you selected 

 

- When stamping is done, per default a texture spawner will apply textures 

to the terrain so you can estimate better what the outcome of applying 

this stamp is (having a rock texture on a mountain, grass on plains etc. 

makes the terrain easier to read). 
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You can repeat this process while moving the stamp around and / or 

selecting different stamps from the stamp selector window to stamp 

additional features on the terrain. When you are satisfied with the result, 

you can look for the “Spawn Biome” button that will place the remaining 

other assets (grass, tree, game objects) from the biome on the terrain: 

 

 
 

This button is just a shortcut for selecting the biome in the scene hierarchy 

and running the spawn from there: 
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You can either press the “Spawn Biome” button in the stamper or navigate 

to the biome and start the biome spawn from there. 

 

 
 

When the progress bar in the centre of the screen disappears and the 

inspector window becomes active again, the biome spawning process is 

complete. Zoom in in the scene view a bit and you should be able to see 

trees and grass on the terrain.  
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Now that you got your first terrain, let’s take the next step to add runtime 

settings to your scene. 

 

5. Bring up the Gaia Manager Window again. It should automatically select 

the runtime tab since you already executed the first two steps of the 

scene creation process. 

 

 
 

This tab shows you the available runtime elements such as Lighting or 

Water that you can add to your scene. Unlike the Gaia Tools, these 
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elements are intended to remain in your final product. You can take a 

look at the available settings and choose what you want to add to your 

scene, again the default settings should be fine for the purpose of this 

guide. Click on “Create Runtime” to add the elements to the scene. 

 

You should notice a huge visual upgrade due to the added sky, lighting 

and water in your scene, especially if you have post processing enabled. 

 

 

 

 

6. At this point your scene is now fully usable and you can click play to see it 

in action. Depending on the selected player type you can fly / wander 

through the scene with the usual WASD + mouse controls. 
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Try to press F11 to bring up photo mode, which allows you to take 

screenshots from your scene using various settings: 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

Note that Photo Mode works in a standalone build as well, saving 

screenshots in the user data folder. This means you can adapt Gaias Photo 

mode to add a photo mode to your own project as well quickly. 

 

This concludes the Gaia Quickstart Guide for the manual workflow using the Gaia 

Stamper. Please read on further below for a guide detailing the World Designer 

(Random Terrain Generation) workflow. 

 

Please Note: This was only the quickest possible introduction to Gaia and we skipped 

a lot of the steps that a more experienced user would take in Gaia, e.g. a more 

detailed terrain sculpting process, and building their own set of spawners according 

to their design goals. 

You are not restricted to using a single stamp and then having to live with the result 

Gaia generates – You can use multiple stamps to form your terrain and control every 

aspect of the spawning process to populate the terrain so you can get exactly the 

result you want. 

Of course you can also add your own assets to Gaia to spawn them on your terrain 

in the same fashion as shown in this quickstart guide. To do so, you would need to 

take a look at the resource settings in the spawner. The online help page for the 

spawner has more information on this topic. 

 

 

 

 

 

 

 

 

https://proceduralworlds.freshdesk.com/support/solutions/articles/33000254751-spawner-introduction
https://proceduralworlds.freshdesk.com/support/solutions/articles/33000254751-spawner-introduction
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Creating a terrain using World Designer (Random 

Generation) 
 

The previous section explained the fundamental steps to create a terrain shape 

manually using the stamper. There is an alternative workflow that replaces the step 

of stamping out the terrain manually with an automated stamp generation to 

create a randomized (but still natural) terrain shape. 

1. To follow along with this guide, open a new scene and bring up the Gaia 

Manager again (Ctrl + G or Window > Procedural Worlds > Gaia > Show Gaia 

Manager). The default settings should be fine again, but this time around 

switch the workflow mode to “World Designer (Random Generation)”  

 

 
 

 

2. Click the “Create World Designer” button. Gaia will open the world designer 

tool for you and will show you a terrain preview that matches the world size 

that was previously selected in the Gaia Manager window. 

 

 

 

3. The terrain shape is random, so your terrain might look different than what you 

see in the screenshot above. The very easiest way to use the world designer is 

to click the “Randomize All” Button. If you click this button, most settings of the 
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random generator will be shuffled, and a new terrain will be generated. Per 

default the world designer creates an island, so you should get a different 

island each time you press the “Randomize All” button. 

 

 
 

4. If you see a terrain shape that you like, press the “Generate World” button, 

and confirm the popup.  

 

 

Gaia will now take the preview shape that was displayed before and will 

create a full unity terrain out of it and spawn the textures from the selected 

biome: 

 

 
 

5. From this point on you could continue now and fully spawn the biome and 

create the runtime setup for lighting / water on this terrain. This works just like in 

the manual workflow using the Gaia stamper. This would be the absolute 
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minimal way to use the World Designer: Use the “Randomize All” button until 

you see a shape you like, and then generate the resulting terrain. However, 

the World Designer has many more features to help you to generate a more 

fitting terrain for your project. 

 

 

6. To explore these settings, return to the Designer again. You can re-open the 

World Designer by selecting it in the scene hierarchy, or by clicking the button 

in the Gaia Scene View Panel: 

 

 

 

7. With the designer in view click the “Clear Stamps” Button to clear the stamps 

that have been created during the last generation run.  

 

 

You should see now a mostly featureless terrain shape in the preview.  
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8. What you are seeing there is the so-called “Base Terrain”. The world designer 

works by taking such a basic terrain shape as input and then enriching it by 

placing multiple stamps on it to create interesting shapes.  

 

So when not doing the full randomized approach via the “Randomize All!” 

button, the workflow in the World Designer is as follows: 

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

A  Set up your World Size (which is taken over from the Gaia Manager initially) 

B  Set up your World Shape / Base Terrain 

C Set up settings for your World Details / Stamps 

D Spawn random stamps on the base terrain 

E  When happy with the results, Generate the World and turn it into full unity 

terrain(s) 

 

In the next steps we will follow this workflow to generate a terrain based on a 

certain base terrain shape. 

 

 

 

 

 

 

 

A 

B 

C 

D 

E 
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9. Begin by opening the World Shape panel. For the sake of the tutorial select 

“Generator” and “Water” and adjust the settings there that all influence the 

base shape of the terrain: 

 

 

 

The most important settings are:  

Shape Input type – Allows you to switch between generating a shape from 

Noise (Generator), using an input image or an already existing terrain. 

Border Style – Allows you to force the borders of your world to be Water (to 

create islands), Mountains or nothing specific. 

Height Scale – Influences the overall height of the base terrain but also of the 

stamps that are placed on it. 

Base height – lifts the entire shape up on the y-axis. 

 

You can find more information about all the remaining settings by clicking the 

“?” icon in the World Shape Panel. Try to create a bit more interesting base 

terrain shape that would still be somewhat recognizable when the stamps are 

spawned, e.g.: 
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10.  Next we can take a look at the World Detail settings which control the stamp 

spawning that will take place on the base terrain. 

 

There are 4 general settings on the top that apply to the way the stamps are 

being spawned on the base terrain: 

 

Stamp Density: Controls the number of stamps that will be placed on the 

terrain. You can drag the slider around to see a preview visualization of the 

stamp areas (each circle represents one stamp that will be placed). There is 

also a checkbox in the scene view panel to activate this visualization 

permanently. 

 

 

Stamp Jitter – controls the randomness in stamp placement – at a Jitter of 0 

the stamps will be placed in a grid-like fashion, at 100 they are shuffled 

around in position to make that pattern less recognizable. 
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Stamp Width – controls the width of the stamps that are being placed. Again, 

the visualization in form of the blue circles pops in when you change the 

value here so you can review the stamp sizes and positioning. 

Stamp Impact – Controls how much Impact on the base terrain shape the 

stamps will have – A high impact means that the imprint of a mountain will be 

rather high, and the imprint of a valley would be rather deep. High Impact 

means that the stamp features are more visible which can make the terrain 

more visually impressive, but it is also possible to overdo it so that the stamps 

become unnaturally distorted. 

 

Please note: These settings can have a huge impact on your final result, and 

“more” does not necessarily mean “better” for these settings. For example, 

here is a generation result with high stamp density, high width and high 

impact: 

 

 
 

 

 

 

 
 

Not a very good result – this happens because too many stamps are placed 

on top of each other and all are overlapping each other multiple times. The 



 

Gaia by Procedural Worlds 

result is an unrealistic mountain with barely recognizable features left, it is 

mostly just noise remaining at that point. 

 

The other extreme is too little, too small stamps that do not overlap with each 

other: 

 

 

 

 

 

Again, not a good result – the featureless base terrain is mostly visible and the 

stamps are not connecting to a cohesive landscape. What you should aim 

for is that the stamps are overlapping a bit, but that the individual stamps 

have enough room to imprint their own features on the terrain: 
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This is a better result – the individual stamps are connected but have still 

enough “breathing room” to display the actual features of the stamp. 

 

The world size, the total available heightmap resolution and scale also play 

into this – if you are creating a multi-terrain scene with 10 x 10 terrains with 

1024 x 1024 meters each, that is a lot more space and total heightmap 

resolution than just a single terrain. You would usually want to place more 

stamps to fill this space with multiple interesting features than you would on a 

single terrain. 
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11. Following the stamp spawning settings are the individual entries for the 

different stamps that the world designer can use during generation: 

 

You can activate those features with the checkboxes, and you can change 

the distribution for those features with the sliders (left = less, right = more). 

Similar to the spawn rules in a regular Gaia Spawner, you can unfold each of 

these rules to display more settings for how and where these stamps will 

appear on the base terrain: 

 

The feature type choses which kind of stamp will be chosen – note that this 

selection is linked up to the Gaia Stamps directory – this means you can add 

your own stamps by adding them to the appropriate directories. Note that 

you can also add additional spawn rules for new feature types at the end of 

the list. 

The remaining settings are: 

Spawn probability – This is the same slider as in the list display and influences 

the overall chance that a stamp of this feature type will be selected.  

Height probability – how the height of the base terrain will influence the 

chance of the stamp to appear (left side of the curve = minimum height, right 

side = maximum height) 

Stamp Height Modifier – controls how the underlying height of the base terrain 

at the spawn spot will influence the height of the spawned stamp. For 

example, if a mountain stamp would be drawn for spawning at a beach, it 
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should receive only reduced height to not fully destroy the underlying base 

terrain shape. 

Invert Chance – Chance the stamp will spawn inverted (A valley instead of a 

mountain) 

Width Range – the possible width for the stamp when spawning (100 = one full 

terrain wide) 

Mix Height Strength – Stamps are spawned using the “Mix Height” operation 

to blend in well with the already existing stamps. This slider controls the 

minimum and maximum strength for this operation according to the Stamp 

Height Modifier above) 

Mix Height Midpoint – another setting from the “Mix Height” operation. This 

setting controls whether the features found on the stamp should be elevated 

above the terrain, or rather should cut down into the terrain.  

The more the slider range is to the left, the more this operation will use the 

stamp to elevate features above the terrain (Which you would want for 

mountain-like stamps) The more it is set to the left, the more it uses the 

features in the stamp to lower the terrain (Better for valleys, rivers, lakes). 

 

12. With the base shape and the stamp spawning settings all set up, we can look 

at the controls for the World Designer that start the stamp spawning process: 

 

“Randomize Stamps” will keep your base shape and will spawn stamps 

according to the stamp probabilities you set up. This is the button to use to 

generate a terrain that sticks to the base shape and where you can try out 

how it will look like e.g. if you decide to increase the mountain probability.  

“Randomize All” will create a random base shape and will also randomize the 

stamp probabilities. This button is suitable if you want a mostly random terrain. 

(This is the button we used earlier in the guide to create the completely 

random terrain) 

“Clear Stamps” will clear all spawned stamps so you can see the base terrain 

shape again. 

 

“Reset To Defaults” will reset the Settings to sensible defaults according to 

your selected World size. 

 

“Generate World” will turn the currently viewed preview into a real unity 

terrain. After the generation you can treat this terrain like a terrain that you 

shaped manually with the Gaia stamper and run (Biome) spawners on it and 

create the runtime setup for lighting, water, etc. 
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13. To complete your terrain generation on a base terrain, click the “Randomize 

Stamps” button. You should see stamps appear on the base terrain that you 

created initially. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you continue clicking the “Randomize Stamps” button, you should get a 

different result, but it should still stick to the base terrain shape.  

 

You can also alter the probabilities for the different stamp feature types to 

force a certain look, e.g. only using Mountain Stamps: 
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 Please Note: Depending on your settings, the generation result can stick more 

or less to the original base terrain shape that you use as input in the world 

designer, up to the point where the original shape is not recognizable 

anymore at all. Depending on what you are trying to achieve, this can be no 

problem, but it can also quite counterproductive if you need the world 

generation to stick closely to the input. As a rule of thumb keep the following 

in check to get a result that sticks close to the base terrain size: 

 

Rather more, smaller stamps than wider ones – Wide stamps tend to destroy 

the original shape more, because e.g. a mountain creates an island outside 

the original shape, or a wide valley destroys the original coastline of the base 

terrain.  

 

Less Stamp Jitter – Due to the shuffled placement from jitter it is more likely 

that two stamps will intersect more to create an unexpected feature that did 

not exist in the original shape. 

Less Stamp Impact – Stamp Impact makes the features of the stamps appear 

stronger on the base terrain, but that of course also alters the base terrain in 

the process. This is a trade-off situation – you want the impact of the stamps to 

be visible of course, but when you are overdoing it, it diverts too strong from 

the original shape as well. 

When creating an island, avoid / reduce Rivers and Valleys – Those tend to 

dig into your original shape too much, so that it diverts more from the original 

shape.  

 

14. The last thing to do when you found a terrain shape that you are happy with, 

is to click the Generate World button. Gaia will warn you that it will remove all 

existing terrains from the scene to export your new terrains. When you confirm 

that, the generation starts and your terrains will be created. Again as before 

you will be able to use your terrain just as if you had created it with the 
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manual stamper workflow before. You can go back into the Designer 

anytime to start a new export if you are not happy with the result. 

 

Pro Tip:  The settings for the World Designer can be saved and loaded again 

via the “Advanced” Panel. In this way you can quickly apply the same 

generation settings in different scenes or projects. 

 

Larger World Sizes / Multi - terrain in the World Designer 
 

In theory there is no size limit in the world designer – if you increase the amount of 

terrain tiles in the world size settings you could generate very large worlds with it. To 

assist you better when creating large worlds, the world designer displays some extra 

controls in the scene view: 

• When working with multiple terrains, initially the world designer will only display 

the stamp spawn result on a single terrain tile like so: 

 

This is done to keep the preview of the resulting stamps somewhat responsive, 

when spawning 100s of stamps it can take a bit to calculate the full preview. 

You can preview other terrain tiles by changing the X/Z tile coordinate in the 

panel in the scene view, or by dragging the white box cursor around. The 

preview should update to the new spot automatically after 2 seconds. To see 

the full preview, you can click the “Render Full Preview” button. This can then 

take a bit, depending on the total amount of stamps, but will display a full 

preview of the terrain when finished. 

 

• The preview can only display a total resolution of 4097 heightmap pixels for 

technical / performance reasons. This means that you can create a world 

that can have a much higher terrain heightmap resolution what is currently 
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displayed in the preview. The scale and size of the preview will still match with 

what is generated, but you would not see every detail in the preview due to 

the lower resolution. If you want to take a look at the actual resolution of a 

single terrain tile, you can do so with the “Zoom In” button. This will Zoom in 

the preview to a single terrain tile which is then rendered at the correct 

heightmap resolution. 

 

 

• When looking at the preview, it can be difficult to estimate the scale of the 

resulting terrain correctly. A small world can take in the same amount of 

screen space than a large world depending on how far you are zoomed in. 

Then when generating the world you suddenly discover that the world does 

offer too little / too much space or your mountains are much smaller than you 

expected from the perspective of the player. To combat this, the world 

designer features the size graph at the borders of the preview. The numbers 

printed on here are world space unity units / meters measured from the 

center of the world at X=0 / Z=0. This helps you to get an impression how 

much space there would be in a certain area.  

• If you scroll in closer to the center of the preview, you will also notice that 

there are a few sample objects being rendered in the scene. These can help 

you to estimate the scale of the terrain features much better. This mountain 

ridge might seem massive at first glance: 
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With the sample scale objects – not so much anymore, the character up front 

could scale this ridge quite quickly: 

 

You can activate handles for these objects in the scene view settings panel, 

this allows you to drag around these objects on the preview to test different 

locations for scaling. 

 

This concludes the introduction for the world designer. You can learn more about 

the world designer in the built-in help features of Gaia, including the link to the online 

manual page for the World Designer. 
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Where to go from here – Next steps 

 
If you have worked your way through the quick start guide, it is recommended to 

start over, but this time around take a deeper look at the individual tools at hand 

and the features that they provide to flesh out your scene. Remember that the 

question mark help button provides help directly in the application and links you to 

more detailed manual articles in our Canopy Library where appropriate. These here 

are the online help pages for the stamper and the spawner tool for example:   

Stamper Online Help 

Spawner Online Help 

These pages far exceed the information covered in this quickstart guide. 

If you want to follow more tutorials before experimenting on your own, you can visit 

the Tutorials Collection on Canopy.  

 

AI Gamedev Toolkit 
Gaia comes with an integration for the AI Gamedev Toolkit – An environment for 

creating Artificial Intelligence solutions in Unity – made in collaboration with AI 

experts from Intel. You can run and modify ready-made AI Inferences such as object 

detection or style transfers directly in the scenes that you made with Gaia. 

 
 

Object 

Detection 

https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/?utm_source=Gaiav320&utm_medium=ManualDocument&utm_campaign=Canopy
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/creating_your_world/2-stamper-introduction-r46/?do=getNewComment&d=1&id=46
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/populating_your_world/1-spawner-introduction-r54/?do=getNewComment&d=1&id=54
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/?utm_source=Gaiav320&utm_medium=ManualDocument&utm_campaign=Canopy
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This integration works with all Editions of Gaia (Gaia ML, Gaia 2021, Gaia Pro 2021) To 

learn more, visit the AI Gamedev Toolkit documentation page on Canopy. 

Gaia GX - (G)aia e(X)tensions 

 
The Gaia extensions system allows Gaia to be extended with other tools and quality 

assets. 

 

We used the Gaia Extension system to include our own sky and water system so that 

you can change the sky and water setup and surrounding settings from this menu as 

well. 

 

Style Transfer 

https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/advanced/ai-gamedev-toolkit-r123/
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To access them, go to the GX tab in Gaia Manager and select Procedural Worlds, 

Skies and Water to modify your time of day, water and post processing settings.  

 

When you select a sky the sun light will be reconfigured, fog colour, density will be 

changed and the skybox. Also, the post processing profile will be changed to the 

appropriate time of day to give the best experience.  

 

You can also add and remove the water with also using a few of the preset 

configurations on the material settings. Lastly you can configure the post processing 

profiles to change them although these dynamically change when you select your 

time of day. 

 

Adjusting the ambient audio volume  
 

In the Hierarchy under Gaia Lighting Environment is the Ambient Audio game object. 

Click on that and then in the Inspector adjust the Volume.  

 

About light baking 
 

Lightmaps are very important as they store the information than the Unity GI system 

needs to light your scene properly.  
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If you are using a skybox and an ambient light source you will not see correct  

ambient lighting in your scene until your lighting is baked. Distance shadow masking 

for game objects and terrain won't be correct until you bake your scene lighting. 

Gaia offers the “Quick Bake” option in the Runtime tab which will populate only the 

basic lighting settings for the scene, so that the ambient light color in the scene will 

be correct. 

You can have both baked and real time lightmapping in your scene also known as 

mixed lighting. Most large projects mix both baked and real time lighting. To learn 

more about light baking and lighting in general, please visit these links: 

 

https://unity3d.com/de/learn/tutorials/topics/graphics/choosing-lighting-technique 

 

https://blogs.unity3d.com/2018/03/09/spotlight-team-best-practices-making-

believable-visuals-in-unity/ 

 

Pipeline Switching 
 

If you need to switch rendering pipelines before starting a new project or during an 

existing project, you can do so via the “Setup” panel in the Gaia Manager window. 

Please see the installation information at the beginning of this guide for more 

information. 

 

https://unity3d.com/de/learn/tutorials/topics/graphics/choosing-lighting-technique
https://blogs.unity3d.com/2018/03/09/spotlight-team-best-practices-making-believable-visuals-in-unity/
https://blogs.unity3d.com/2018/03/09/spotlight-team-best-practices-making-believable-visuals-in-unity/

